Development of an Educational Three Dimensional Model
to Describe the Masticatory Apparatus of the Phalangeroid
Possum: *Trichosurus vulpecula*

by
Nicholas S. Reback

A thesis submitted to Johns Hopkins University
in conformity with the requirements for
the degree of Master of Arts

Baltimore, Maryland
March, 2017

© 2017 Nicholas Reback
All Rights Reserved
Phalangeroid possums of New Guinea and Australia possess many traits convergent with Malagasy Strepsirrhines and provide researchers with an opportunity to shed light on the order of adaptive traits that lead to the appearance of the first primate. Like Strepsirrhines, phalangeroids are thought to have evolved in geographic isolation. They are well adapted to arboreal life through traits such as grasping hands and feet with reduced claws and an opposable first digit on the hind foot, increased orbital convergence for better depth perception and an overall large brain to body size ratio. While Strepsirrhines have been well studied from several scientific perspectives, data on phalangeroids is limited to morpho-ecological observations.

A strong case has been made for in-depth study of phalangeroids. A logical place to start is with the jaw adductors and dentition as such information provides scientists with an important foundational understanding of mammal phylogeny, adaptive history, diet and trophic structure. Characterization of any mammalian masticatory apparatus, however, requires a thorough understanding of spatial relationships as well as biomechanical traits derived from muscle mass, fiber length, physiological cross-sectional area and location of attachments sites. This task is challenging enough for a single species and is increasingly difficult when comparing two or more taxa. Unfortunately, the tools most commonly employed to document the three-dimensional nature of chewing muscles are limited to two-dimensional outputs such as text, quantitative data displays, black and white line drawings and photography. To make matters worse, the efficacy of such tools is compromised by poor quality of execution.

This study aims to improve the ability of the scientist to draw meaningful comparisons between two taxa, Malagasy Strepsirrhines and phalangeroid possums, by introducing a refined set of visual communication tools including traditional flat illustration as well as a three dimensional reconstruction driven by volumetric data acquired from dissection of a single representative phalangeroid species, *Trichosurus vulpecula*. It is our hope that the contribution of these resources to the scientific community will help further the academic discussion regarding the evolutionary sequence of adaptations that define the order Primate.

*Chairpersons of the Advisory Committee for Nicholas Reback*

Jonathan M.G. Perry, MSc, PhD, Assistant Professor,

Center for Functional Anatomy and Evolution

Jennifer A. Fairman, MA, CMI, FAMI, Associate Professor (Faculty Advisor)
For Thomas H. Garver
The successful completion of this thesis would not have been possible without the direct assistance of many important individuals. My preceptor, Jonathan M.G. Perry, MSc, PhD, Assistant Professor in the Center for Functional Anatomy and Evolution at the Johns Hopkins University School of Medicine, brought forth the idea of the project to our department. Dr. Perry provided direction, support and wisdom throughout each and every phase. His knowledge, enthusiasm, and affable personality were not only what drew me to the project, but I believe were vital to transcending our collaboration into a compelling narrative.

Jennifer Fairman, MA, CMI, FAMI, Associate Professor in the Department of Art as Applied to Medicine (whom I refer to as “skillz,” for there is no other word that can as succinctly capture her unquestionable talent and ability), served as my graduate advisor as well as strategic and emotional counselor. I have never felt so in sync with a creative professional as Ms. Fairman. Her criticism was always constructive and her honesty refreshing. It would behoove the scientific community to develop a better understanding of the dynamic qualities that make up the personality of someone like Ms. Fairman.

Juan Garcia, MA, CCA, Associate Professor in the Department of Art as Applied to Medicine, served as my unofficial second advisor throughout the digital sculpting, prototyping and manufacturing phase. Mr. Garcia possess immeasurable patience, a trait I drew inspiration from while navigating the more experimental phases of the project. He generously contributed his time to help troubleshoot software anomalies and the inherently persnickety nature of the 3D printing process.

My friend and classmate Sarah A. Chen, future MD, has been a constant source of support throughout my time at Hopkins. Sarah encouraged me to stay healthy and release stress through exercise and engage the outside world during moderate Friday night beer consumption in Fells Point. She also took on the responsibility of maintaining the 3D printer and was often there to help guide me through much of the printing process.

There are many individuals that played a small but critically important role at various junctures that deserve recognition: John Ososky and Darrin P. Lunde at the Smithsonian Institution Museum Support Center in Washington, DC, who helped arrange the visits for myself and Dr. Perry to conduct our dissections; Justin Ledogar, PhD, at the University of New England, New South Wales, Australia, who provided the CT data of the Trichosurus vulpecula cranial specimen; Amir Manbchi and Alex Martin at the Johns Hopkins Hospital Carnegie Center for Surgical Innovation who hosted me in their lab on several occasions during the 3D printing phase; Elizabeth St. Clair, PhD, Adam Sylvester, PhD, Siobhan Cooke, PhD, as well as graduate students Stephanie Canington and Kristen Profort at the Johns Hopkins Hospital Carnegie Center for Surgical Innovation who hosted me in their lab on several occasions during the 3D printing phase; Elizabeth St. Clair, PhD, Adam Sylvester, PhD, Siobhan Cooke, PhD, as well as graduate students Stephanie Canington and Kristen Profort at the Johns Hopkins Hospital Carnegie Center for Surgical Innovation who hosted me in their lab on several occasions during the 3D printing phase.
University School of Medicine, Center for Functional Anatomy and Evolution, who provided valuable input that was used to establish design criteria for the project.

I would like to thank the incredible faculty at Johns Hopkins University School of Medicine, Department of Art as Applied to Medicine, whom are all masters of their respective craft within the field: Corrine Sandone, Timothy Phelps, Gary Lees, David Rini, Ian Suk and Lydia Gregg. The skills I acquired under their direction as a first year medical illustration student were foundational to completion of this thesis. My amazing classmates Eleanor Bailey, Katie Bergdale, Daniel Hermansen, Julia Lerner and Li Yao were a wonderful source of inspiration and support as well.

I would like thank the Vesailus Trust as well as the Department of Art as Applied to Medicine, and the Center for Functional Anatomy and Evolution at The Johns Hopkins University School of Medicine for granting financial support for the project.

The dream of studying Medical Illustration at Johns Hopkins University would not have become reality without the love and support of many individuals for whom I am eternally grateful. First and foremost I would like to thank the support my parents, John and Renee Reback and my sister Sonia, who sent me several pairs of dress shoes in preparation for my return to the professional world, and my brother Alex, who dutifully watched over my cat, Russel Meowmerson, during my academic journey. I would also like to thank many close friends and relatives in Wisconsin and abroad who provided support in their own way during my journey: my dear friend Tom Garver, to whom this work is dedicated, and his wife, the artist and designer Natasha Nicholson, Mr. and Mrs. Richard Teteak and their sons Robert and Daniel along with his wife Susan, Kristopher and Julia Steege-Riemann, Kristine Euclid, Doug Steege, and Aunt Jeannie and Uncle Jack Erhart.
# Table of Contents

**Abstract**  
**Acknowledgements**  
**Introduction**  
**Materials and Methods**  
I: Species Selection  
II: User Interviews and Establishment of Design Criteria  
III: Data Acquisition and Processing of Hard Tissue  
  Step 1: Horos Segmentation  
  Step 2: Reorientation and Auto-Grouping in ZBrush  
  Step 3: Artifact Removal  
  Step 4: Symmetrization  
  Step 5: Detail Refinement  
IV: Dissection of the Masticatory Apparatus  
V: Digital Muscle Reconstruction in Z-Brush  
VI: 3D Printing  
  Step 1: File Preparation  
  Step 2: Processing STL files in MeshMixer  
  Step 3: Importing into Stratasys Objet Studio  
VII: Creation of Assembly Features  
  A: Creating Press Fittings  
  B: Creating Pocket Features for Magnets  
VIII: Surface Patterns for sites of Origin and Insertion  
IX: Digital Renderings  
  Step 1: UV Maps  
  Step 2: Polypainting and Texture Map creation  
  Step 3: GoZ Export to Cinema 4D  
  Step 4: Scene Rigging in Cinema 4D  
  Step 5: Texturing in Photoshop
# Table of Contents

## Results

I: Design Criteria .................................................. 37
II: Flat Illustration .................................................. 37
III: Digital Reconstruction ....................................... 42
   A: Physical Model .............................................. 42
   B: Virtual Model .............................................. 45
IV: Anatomy of Musculature ..................................... 45
V: Workflow Documentation ..................................... 51
VI: Asset Referral .................................................. 53

## Discussion

II: Production Goals and Challenges .......................... 54
II: Digital Workflow .............................................. 55
   A: Z Brush ...................................................... 55
   B: Cinema 4D .................................................. 55
III: Physical Workflow .......................................... 55
   A: Dissection .................................................. 55
   B: 3D Printing ................................................. 56
   C: Response to the Physical Model ....................... 56

## Appendix ................................................................ 58

## Bibliography ...................................................... 62

## Vita ..................................................................... 64
Figure 1. The phalangeroid possum *Trichosurus vulpecula* (left) and Strepsirrhine primate *Otolemur crassicaudatus* (right). *Photo credit: Gerald Cubit, Arkive Digital Media © 2011.*

Figure 2. Combined geologic timescale and Phylogenetic tree of mammal forms.

Figure 3. From left to right, adult *Trichosurus vulpecula* specimens #236802 (male) and #236806 (female). Both harvested from Australia between 1920-1923.

Figure 4. Horos toolbar (A). Zoomed in view of “Mouse button function” tools (B). Location of Pencil tool (C). Not all text intended to be read.

Figure 5. Drawing of the first ROI. Note relatively simple shape and location of image within dataset. Not all text intended to be read.

Figure 6. Drawing of second ROI with shape close to that of first. Position within data set is approximately 20 images further to the right. Not all text intended to be read.

Figure 7. Horos window showing position and spread of hounsfield unit histogram and 3D volume rendering. Location of gradient tool icon (A). Location of “16-bit” button (B). Not all text intended to be read.

Figure 8. 3D Surface rendering drop down menu for export of 3D surface rendering. Not all text intended to be read.

Figure 9. Location of drop down menu for export of 3D surface rendering.

Figure 10. Areas of soft tissue projecting off bone (A). Projecting soft tissue removed and hidden mesh deleted (B). Result after closing holes (C). Refined surface after smoothing (D).

Figure 11. Unedited import of Horos data (left). Horos data after refinement within ZBrush (right).

Figure 12. Screen capture of Spotlight images loaded onto canvas within ZBrush.

Figure 13. Incision pattern for dissection of left jaw adductors. Solid lines indicate subcutaneous incisions.

Figure 14. Dissection workstation at the Smithsonian Museum Support Center in Washington, DC.

Figure 15. Masked area of zygomatico-mandibularis insertion (A). New subtools (arrows) created after using extraction function (B). Overlapping meshes after deformation (C). Resulting mesh after merging and retopologizing with dynamesh (D). Refined general shape of muscle (E). Muscle as viewed through bony anatomy (F).

Figure 16. Subtool menu indicating new subtools created from extraction (arrows).

Figure 17. Extract menu with settings used. (S Smt = 5, Thck = 0.02).

Figure 18. Left cranium (transparent) and offset subtool (opaque) with zygoma removed (A). Left mandible (transparent) and offset subtool (opaque) (B). Offset left zygoma (C). Close up of previous view (D).

Figure 19. SolidWorks part window (right) with enlarged view of Mass/Section Property Options menu (left). Not all text intended to be read.
**Figure Index**

*Figure 20.* Superficial temporalis before (left) and after (right) subtracting areas of connective tissue. .......................... 20

*Figure 21.* Primary layer of texture added with the Clay Build-Up brush (A), then smoothed (B). Secondary layer of texture using a slightly smaller brush size (C), then smoothed (D). Creating creases in select areas with the Damien Standard brush (E). Finest level of detail, Rake brush used to convey connective tissue near origin (F). ................................................................. 21

*Figure 22.* Arrangement of select subtools for printing first prototype. Right cranium and mandible have been split (see Step 1, below) and were fixed together with posts. Superficial temporalis and zygomatico-mandibularis offset from surface with medial pterygoid repositioned inside braincase of right cranium (arrow). ................................................................. 22

*Figure 23.* Initial placement of appended Polymesh 3D cube (A). Resized cube positioned to slightly overlap midline (B). Position and size of duplicated and mirrored cubes (C). Resulting right cube, ZRemeshed, after subtracting overlap with left (D). ........................................................................................................ 23

*Figure 24.* Enlarged view of Analysis tools within Meshmixer (left). Inspector tool (arrow) is used to analyze mesh for unclosed contours (indicated by red ball and stick, right). Not all text intended to be read. ........................................................................ 24

*Figure 25.* Objet studio window with preview of STL files on printer bed (text not intended to be read). ......................... 25

*Figure 26.* Deep temporalis is held in place through naturally occurring interlocking geometry. ................................ 25

*Figure 27.* Post extruded from pterygoid fossa (arrow) to allow retention of the medial pterygoid. ................................. 26

*Figure 28.* Press fitting with pocket for magnet to attach pterygoids to one another. .................................................. 26

*Figure 29.* Shape of new polygroup made from duplicated mandible subtool (A). Resulting mesh after hiding and deleting remainder of duplicated mandible (B). Topology before (C) and after (D) removal of facets and ZRemesh operation. Before (E) and after (F) flattening using the Planar brush. Extruded shape using ZModeler brush with Qmesh action and Flat Island target (G). Position of extrusion on original mandible subtool (H). ........................................................................................................ 27

*Figure 30.* Dimensions of magnet (top left) and tolerance model (lower left). Orthographic view of magnet (dotted white line) within tolerance model. Reference line (arrow) used for alignment during Boolean subtraction. Not all text intended to be read. ........................................................................ 29

*Figure 31.* Isometric perspective drawing of embossed pattern for origin (left) and debossed pattern for insertion (right). ........................................................................................................ 29

*Figure 32.* Layers palette showing deep temporalis layer set to record (A2), new layer button (A1), and Bake All button (A3). Deformation palette with Offset set to -0.75 (B). Alpha palette (C) indicating pattern (C1), inverse button (C2) and tiling adjustment sliders (C3). ........................................................................................................ 30

*Figure 33.* Creating origin and insertion patterns on right cranium. Masked area for Deep temporalis origin (A). Inverted mask (B). Surface targeted for patterning is raised with using Deformation>Offset tool (C). Origin pattern on surface after using Standard brush with Drag-Rect stroke with alpha pattern (D). ........................................................................................................ 30

*Figure 34.* Screen captures of the UV Master and Texture Map palettes within ZBrush. Numbered arrows indicate order of steps outlined in text as well highlight the counter-intuitive design of the interface. ........................................................................................................ 32

*Figure 35.* Cloned Deep temporalis subtool with control painting applied (A). Display of seam after performing an Unwrap (B). Subtool with polypaint applied (C). ........................................................................................................ 32
Figure Index

Figure 36. Screenshots of lighting rig within Cinema 4D: main area light (A), primary fill light (B), secondary fill light (C) and ambient light (D). ................................. 34

Figure 37. View of shaders within Material Manager of the Cinema 4D project file. ................................. 35

Figure 38. Screenshot of take manager window indicating New Take (A), Auto Take (B), Lock Override (C) and Render All Takes to PV buttons (D). Not all text intended to be read. ................................. 35

Figure 39. Texture map before (left) and after (right) addition of detail. ................................................. 36

Figure 40. Anatomical landmarks of the cranium, (Trichosurus vulpecula). ........................................... 38

Figure 41. Anatomical landmarks of the mandible (Trichosurus vulpecula). ........................................... 39

Figure 42. Origin and insertion of the Masseter group (Trichosurus vulpecula). ...................................... 40

Figure 43. Origin and insertion of the Temporalis group and Pterygoids (Trichosurus vulpecula). ................. 41

Figure 44. Photograph of the final physical model in assembled form. .................................................. 42

Figure 45. Photographs of the final model, caudal (top) and disassembled (bottom). ............................. 43

Figure 46. Photography of the first (top) and second (bottom) prototype. ........................................... 44

Figure 47. Musculature, superficial layers. ............................................................................................... 47

Figure 48. Deep layers of the Masseter group. ....................................................................................... 48

Figure 49. Deep layers of the Temporalis group. ................................................................................... 49

Figure 50. Position of the Pterygoids. ..................................................................................................... 50

Figure 51. Workflow diagram separated into digital and physical tasks. ............................................... 52
**Introduction**

All modern mammals, with the exception of monotremes, diverged from a common therian ancestor during the late Jurassic approximately 160 million years ago (Luo et al, 2011) (fig 1). Today, of the 5420 known mammal species, 335 are represented by metatherian (marsupial) radiations that primarily inhabit the forested regions of New Guinea and Australia, with a small number found in the New World ecosystems of South and Central America, plus a single species in North America (Vaughn, 2011; Mitchell, 2014). By contrast, the range of inhabited ecological niches and variety of adaptive traits possessed by eutherians (placentals) is far more diverse (Vaughn, 2011; Swindler, 2012). One such group, the Lemuriformes of Madagascar, of the suborder Strepsirrhini, are of considerable interest for their possession of primitive primate-like adaptations. Both extant and extinct taxa provide researchers with insights as to the order of adaptations that led to the radiation of arboreal primates from a pre-primate insectivore, presumably a plesiadapiform, sometime near the Paleocene-Eocene boundary (Cartmill, 1974; Bloch, 2001; Lou, 2011; Swindler, 2012). The fossil record for such antecendents, however, remains curiously absent (Swindler, 2012; Sussman, 1991). Evolutionary hypotheses about the order of acquired traits leading to Eocene prosimian varieties and, hence, modern primates are in a perpetual state of debate (Kay et al., 1990; Beard, 1993; Bloch and Silcox, 2001; Silcox, 2001).

One theory, the “visual predation hypothesis,” was proposed by Matt Cartmill in his 1972 article in *Science* titled Rethinking Primate Origins. Cartmill argued that of the 14 orders of terrestrial mammals, 9 are arboreal and many of these, while highly successful as tree dwellers, are without possession of primate traits. He noted the locomotor habits of squirrels, the tree climbing ability of cats, and the prehensile forelimbs of chameleons among his examples. Prehensile hands and feet were quite common among shrub layer insectivores during the Eocene, while optic convergence was restricted to nocturnal predators of insects. Visual predation of insects in the lower canopy is a characteristic of extant prosimian forms (Tarsiers and Galagos) as well as some marsupials. Early primates, therefore, must have been nocturnal predators of insects in the lower canopy that relied on improved performance of the visual system to slowly stalk arthropods on terminal branches. Additionally, Cartmill argued that the plesiadapiform was a close collateral relative of early primates, rather than an antecedent form.

A more recent theory dubbed the “angiosperm exploitation hypothesis,” proposed by Robert W. Sussman in the American Journal of Primatology in 1991, has been steadily gaining support. This is partly due to new data that demonstrates olfaction and auditory sensitivity to high frequencie, rather than stereoscopic vision, are a primary means of predation among omnivores. Galagos and Tarsiers are now know to use both
**Introduction**

traits to stalk prey on the ground and not in trees or shrubs. Cats, likewise, rely almost exclusively on hearing to find predators scurrying beneath terrestrial detritus. The most supportive evidence of Sussman’s theory, however, is contained in the fossil record from the late Paleocene-mid Eocene that demonstrates a rapid and diffuse coevolutionary event of flora and fauna. Up to the late Cretaceous, the diaspore size of angiosperms remained relatively small, indicating of abiotic dispersal, and pollination is thought to have been performed primarily by insects. As the Tertiary approached, the size of diaspores as well as the range of angiosperm habits increased. This coincided with new radiations of birds, plesiadapoids, marsupials and other groups in distinct regions, all of whom who benefited from the increased availability and diversity of plant products. The size of angiosperm products remained relatively constant throughout most of the Paleocene, but as competition for plant products is thought to have increased, along with their consumption, new defensive adaptations among flora as well as more efficient means of exploiting these resources among biotic dispersers followed. Thus, Sussman argues, the impetus for diversification of mammals during the early Tertiary was a diffuse coevolution of both flora and fauna and the appearance of the earliest primate was not an isolated phenomenon.

Intuition suggests that increased phylogenetic distance between two or more taxa correlates with greater morphological variation in modern forms. When comparing the order Primate to all other mammals, this assumption appears correct. They are defined by a unique combination of several important adaptations including grasping hands and feet with opposable first digits and nails instead of claws, hind limb locomotor dominance, late onset sexual maturity, stereoscopic vision and reduced olfaction, large brain to body size ratios, and complex social behavior (Vaughn, 2011; Swindler, 2012; Rasmussen, 2007; Cartmill, 1972;). The unfortunate aspect of primate phylogeny is that there are few opportunities for evolutionary scientists to test theories about the order and timing of these acquisitions. Evolutionary time far exceeds the lifespan of the researcher and there is no way to control for any particular variable during evolutionary runs to determine the effect of a single variable on an outcome.

It is fortuitous then that the phalangeroid possums of Australia and New Guinea, with a long history of independent radiation in similar ecological niches to that of Malagasy Strepsirrhines, possess so many morpho-ecological convergences (Smith, 1996; Freedland, 1975) (Fig 1, 2). Like Strepsirrhines, phalangeroids are thought to have radiated in geographic isolation by benefiting from a lack of competition for angiosperm products from other dispersers such as bird and bats (Lillegraven, 1974; Sussman, 1991). They are well adapted to an arboreal habitat and possess prosimian-like features such as grasping hands and feet with reduced claws and an opposable first digit on the hind foot, increased orbital convergence for better depth perception and a larger overall brain to body size ratio (Cartmill, 1972; Sussman, 1978; Rasmussen, 2007). They have similarly low reproductive rates and certain species, such as *Cercartetus*, exhibit social tendencies in their
I/n/sc/t.sc/r.sc/o.sc/d.sc/u.sc/c.sc/t.sc/i.sc/o.sc/n.sc

nesting behavior (Rassmussen,2007). The strongest evidence of primate-phalangeroid convergence obtained thus far has been observed in their dietary habits. Larger body-sized Lemuriformes and phalangeroids tend to be frugivore-folivores while in smaller genera frugivore-insectivory has been observed (Freedland, 1975; Goldingay and Kavanagh, 1995; Smith, 1996; Dumont, 2000; Rassmussen, 2007). A particularly uncanny convergence occurs with respect to the post-cranial morphology and foraging strategies between the Malagasy aye-aye (Daubentonia) and non-gliding striped possum (Dactylopsila). Both are extractive foragers on larval insects and possess enlarged incisors used to gouge wood and open tunnels of wood-boring larvae. The forefeet are used to tap the wood in an apparent use of auditory cues to detect hollows beneath the tree surface. Caches of larvae are then reamed out their bores by way of an elongated finger with a hooked claw (Erickson, 1990).

The current data on phalangeroids are limited to the types of morpho-ecological observations mentioned above and a strong case has been made for increased breadth of scientific studies (Sussman, 1978; Smith, 1996; Rasmussen, 2007). A logical place to begin is to study jaw adductors and dentition as such information can provide an important foundation to understand mammal phylogeny, adaptive history, diet and trophic structure (Vaughn, 2011). Many such studies have been undertaken with regards to Strepsirrhines (Hiiemae and Kay, 1973; Vinyard et al, 2003; Perry and Hardstone-Rose, 2010; Perry et al, 2011) and if analogous information is uncovered among phalangeroids, a deeper objective comparison between the two becomes possible.

Characterization of any mammalian masticatory apparatus, however, requires a thorough understanding of anatomical and spatial relationships as well as biomechanical traits derived from measurements of muscle mass, fiber length, physiological cross-sectional area and location of attachment sites (Taylor and Vinyard, 2004; Taylor et al, 2009; Perry et al, 2011; St. Clair et al, in prep; Harper, in...
Introduction

review). This task is challenging and time consuming for both the scientist and student, whereas a detailed comparison between two or more unrelated taxa becomes increasingly difficult. It is unfortunate then that the tools currently used to document the three dimensional nature of mammalian jaw adductors are often limited to two dimensional outputs such as text, quantitative data displays, black and white line drawings and photography. To make matters worse, the communicative efficacy of these tools is compromised by not only the limits of 2D space, but also the quality of execution (Stark, 1933; Gaspard et al., 1973; Ross, 1995). The main goal of this study is to improve the ability of the audience to draw meaningful comparisons between two taxa, Strepsirrhines and phalangeroids, by introducing a refined set of visual communication tools including traditional flat illustration and, more importantly, a volumetrically accurate 3D physical and virtual reconstruction of the phalangeroid masticatory apparatus. The secondary goal of this study is to document the reconstruction workflow so that additional 3D representations of subsequent mammalian masticatory apparatus can be created by third parties and thus continue to build upon the collective knowledge comparing Strepsirrhines and phalangeroids. It is the hope that the contribution of these resources to the scientific community will help further the academic discussion regarding the evolutionary sequence of adaptations that define the order Primate.
Figure 1. Combined geologic timescale and phylogenetic tree of mammal forms.

Source: Geological Society of America; Swindler 1998; Vaughn, 2011; Mitchell 2014; Luo 2011.
I: Species Selection

The family Phalangeridae is contained within the order Diprotodontia, and includes 6 genera and 72 extant species of both possums and cuscuses (Smith, 1996; Vaughn, 2011). While several other possum families have been noted for their similarities to Strepsirrhines, our study was limited by the regional availability of specimens. The Smithsonian Institution National Museum of Natural History in Washington, DC, was sought out for its collection of fluid preserved phalangeroid specimens which included the following genera: *Phalanger*, *Trichosurus*, *Potorus*, *Petauroides* and *Pseudocheirus*. Of these only *Trichosurus* and *Pseudocheirus* were suitable in both quantity, maturation level and state of preservation to qualify for dissection. *Trichosurus vulpecula* was chosen as a primary candidate for study because of the aforementioned factors, but also because it is the most well documented genus with respect to morpho-ecological observations and is at low risk in terms of species conservation (fig 3).

II: User Interviews and Establishment of Design Criteria

To more fully understand needs of the audience, qualitative user interviews were conducted with three professors and two graduate students at the Center for Functional Anatomy and Evolution at the Johns Hopkins University School of Medicine. The interview protocol and detailed summary of responses can be found in the appendix at the back of this document. Users were interviewed individually in a private setting and audio for each interview recorded and later transcribed. The interview was divided into two parts. Part

![Figure 3. From left to right, adult *Trichosurus vulpecula* specimens #236802 (male) and #236806 (female). Both harvested from Australia between 1920-1923.](image-url)
one asked participants to describe their scientific background, the importance of chewing muscles to their current work, and aspects of the chewing muscle anatomy that were the most challenging to comprehend. Part two asked participants to describe the range and depth of their familiarity with currently available visual tools used to communicate information about chewing musculature. This section also asked users to describe what an ideal visual tool on the subject of chewing muscles would look like. The design criteria born out of these interviews is presented in the results section of this document.

III: Data Acquisition and Processing of Hard Tissue

Step 1: Horos Segmentation

Three dimensional data of *Trichosurus* cranial anatomy was acquired by computed tomography at a slice resolution of 0.1063 mm using a GE Phoenix V Tome XS Industrial High Resolution CT/X Ray Scanner housed at the University of New England, New South Wales, Australia. A total of 856 images were processed in Horos, a free DICOM medical image viewing software. Upon initially generating a three dimensional volume from the scan data, it was observed that the interior of the nasal passages, sinus cavities, brain case and diploe of the zygomatic arches and mandible possessed significant amounts of sparse data, or noise, that would be problematic at the time of physical prototyping. To solve this, noise was removed using the Region of Interest functionality within Horos. The steps involved in this process are outlined below.

1. Scroll to an image within data set where an ROI generation is desired
   - goto ROI>Set Default ROI Name, and enter desire name for new ROI
2. Draw an ROI
   - Select the Pencil tool (fig 4), draw around region of interest
   - Keep ROI’s to simple shapes (fig 5). Complex shapes will generate undesired results.
   - Do not draw more than one shape on any image for a single ROI.
3. Drawing the second ROI
   - Scroll through data set to next desired image (approximately 10-20 images) where the anatomical region undergoes a modest change of shape (fig 6)
   - This ROI will be stored under the name originally specified

*Repeat steps 1-3 as necessary as desired for an anatomical region*

4. Generating missing ROI’S, or “in-betweens”
   - Main Menu: ROI>ROI Volume>Generate Missing ROI’s
5. Check shapes of the generated ROI’S
   - Scroll through images and look for undesired results
Materials & Methods

- use Repulsor tool to nudge ROIs or...
- delete the ROI and redraw with the Pencil tool.

6. Change the pixel value within the ROI

- goto ROI>Set Pixel Values to... and input the following settings
  - Apply to: “ROI’s with the same name as selected ROI”
  - Set pixels that are: “Inside ROI’s”
  - If current value is larger that: “0”
  - If current value is smaller than: “1000”
  - To this new value: “1000

The region within the ROI’s will be set to white.

Steps 1-6 were repeated to generate additional sets of ROIs for each anatomical region. The next step involved generating a 3D volume rendering (Main Menu: 3D Viewer> 3D Volume Rendering). Hounsfield units were adjusted to remove additional noise and soft tissue artifacts (select 16-BIT button, then the “gradient” icon, adjust histogram display of hounsfield units will at the bottom of the screen) (fig 7). Width and height of the histogram was adjusted until the rendering preview appeared suitable for surface generation (Main Menu 3D Viewer>3D Surface Rendering). A drop down menu appeared and the values for smooth iterations and pixel value were set to 100/186, respectively (fig 8). This improved the surface quality of the model upon export. Lastly, a Wavefront OBJ file was exported for use in 3D modeling software. This functionality can be found by opening the drop down menu next to the “gear” icon at the top right of the tool bar (fig 9).

Figure 4. Horos toolbar (A). Zoomed in view of “Mouse button function” tools (B). Location of Pencil tool (C). Not all text intended to be read.
Figure 5. Drawing of the first ROI. Note relatively simple shape and location of image within dataset. Not all text intended to be read.

Figure 6. Drawing of second ROI with shape close to that of first. Position within data set is approximately 20 images further to the right. Not all text intended to be read.
Materials & Methods

Figure 7. Horos window showing position and spread of hounsfield unit histogram and 3D volume rendering. Location of gradient tool icon (A). Location of “16-bit” button (B). Not all text intended to be read.

Figure 8. 3D Surface rendering drop down window.

Figure 9. Location of drop down menu for export of 3D surface rendering. Not all text intended to be read.
Materials & Methods

Step 2: Reorientation and Auto-Grouping in ZBrush

The OBJ file of the segmented anatomy was imported into ZBrush, a polygonal-based 3D modeling software. Upon import, the cranium and mandible were positioned in an oblique orientation. Using the **Move** and **Transpose** tools, they were rotated independently until an orthogonal orientation was attained. The imported data included superfluous topology that was non-continuous with the bony anatomy, such as the scanning bed and noise within the scan field. This information was quickly removed by using the automatic polygroup function (**Tools>Polygroups>Autogroups**) that regrouped the mesh based on surface continuity. Next, the cranium and mandible were isolated (**Command + Shift>click on the bony anatomy**) and the hidden mesh data deleted (**Tools>Geometry>Modify Topology>Delete Hidden**). With the non-continuous geometry removed, the cranium and mandible were retopologized using the dynamesh function at a resolution of 600. This greatly reduced the polycount and allowed for a more lightweight model, without losing detail. The model was now ready for refinement.

Step 3: Artifact Removal

The next step in processing the model involved continuous artifact removal, smoothing, symmetrization of the cranium and mandible, and refinement of detail around the dentition and suture lines. The scanned specimen was not free of soft tissue and there was significant obfuscation of the dentition and muscular attachment sites. Several strategies were employed to correct this. The **Lasso brush** (**Control**... **Figure 10. Areas of soft tissue projecting off bone (A). Projecting soft tissue removed and hidden mesh deleted (B). Result after closing holes (C). Refined surface after smoothing (D).**
+ Shift) was used to select and hide mesh data that projected off surfaces of the model. The hidden mesh was then deleted (Tools>Geometry>Modify Topology>Delete Hidden) and the resulting holes closed (Tools>Geometry>Modify Topology>Close Holes). The closed surface was then blended into the surrounding topology with the smooth brush. These steps were repeated on the remaining surfaces where necessary (fig 10).

Step 4: Symmetrization

Before detailed sculpting could take place, the model was made symmetric across a midsagittal plane. There are several advantages to doing so. First, with symmetry active (Tools>Activate Symmetry> select axis X,Y, or Z), details that appear bilaterally can be sculpted simultaneously, greatly speeding up the workflow. Second, inconsistencies across the midline such as missing anatomical landmarks may cause confusion among the audience, lower the perception of quality, and reduce overall confidence in accuracy. Lastly, it was desired to have the option of a bilateral reconstruction of the musculature. A symmetric model would allow mirroring of subtools after creation on a single side, a significant time savings.

Holding shift while using the Slice Curve brush, both the mandible and cranium were bisected close to the midline. The least desirable side of the model was then hidden and deleted. The remaining side was duplicated (Tools>Subtools>Duplicate) and mirrored (Tools>Deformation>Mirror, select axis). With each half adjacent to each other in the subtool palette, the two halves were merged (Tools>Subtools>Merge>Merge Down) and dynameshed at 600 resolution into a single continuous mesh. Because both cranium and mandible were not split exactly on center, a slight seam, or flashing, appeared after unification. This was easily removed using a combination of the Standard, Damien Standard, and Smooth brush where necessary.

Step 5: Detail Refinement

Using photographic reference as well as a physical Trichosurus vulpecula cranial specimen acquired from the Smithsonian National Museum of Natural History, details around the dentition and suture lines were resolved. To improve the efficiency of this process, reference images were loaded onto the canvas using the Spotlight feature within ZBrush. By default, ZBrush recognizes spotlight images as projection maps for purpose of image based texturing of a mesh. Once loaded, sculpting beyond the border of the image will be restricted, so Spotlight Projection must be disabled (Brush>Samples>deselect Spotlight Projection). Images were loaded by activating Spotlight (Shift + Z) and importing them as textures (Texture>Import>select file). They were then copied to the canvas (select image > Add to Spotlight) upon which a radial marking menu appeared. The opacity, size and arrangement of the images were adjusted and once satisfactory the
Materials & Methods

Spotlight menu was turned off ("Z"). Like Spotlight Projection, the menu restricts sculpting within the image boundary. An example of Spotlight images on the canvas can been seen in Figure 11.

Figure 11. Screen capture of Spotlight images loaded onto canvas within ZBrush.

With the symmetry function active, a combination of brushes were used to resolve various details. The Damien Standard brush employs a falloff parameter to allow sculpting of fine lines cut into or pulled out from the surface. This was especially useful around the base of the dentition, the dental occlusal surfaces, and suture lines on the cranium. The Smooth Brush was used sparingly on the labial or buccal surfaces. Because of the detailed nature of dentition, any gross addition or subtraction of dental surfaces was carefully avoided. While this project is not a study in phalangeroid dentition, the objective with respect accuracy was to prevent the invitation of doubt by the audience. Resolving the dentition was important to achieving this goal. Eventually, remaining surfaces were carefully blended to remove the overall stair-stepped appearance, a natural artifact of CT data segmentation (fig 12).

Figure 12. Unedited import of Horos data (left). Horos data after refinement within ZBrush (right).
### IV: Dissection of the Masticatory Apparatus

The left side masticatory apparatus of four *Trichosurus vulpecula* specimens was dissected, however, two specimens were discovered to be juvenile and not used in the final data set. Only the details important to phalangeroid masticatory dissection are noted here. First, an approximately seven centimeter midline incision on the dorsum of the cranium was made with a #15 curved scalpel, followed by a circumferential incision in the coronal plane approximately 1 cm distal to the tip of the snout. The skin was reflected inferiorly up to the external auditory meatus and conjunctiva of the eye, at which time a circumferential subcutaneous incision was made around each. Finally, a 5-6 cm midline incision on the ventral surface of the mandible was made and the skin reflected caudally exposing the entire masticatory apparatus.

The Masseter group is the most superficial of the jaw adductors and contains four layers. From superficial to deep these are the superficial masseter, external part of the external adductor (EPEA), internal part of the external adductor (IPEA), and zygomatico-mandibularis. The posterior aspect of the superficial masseter is covered by the parotid gland, which was carefully excised. A shallow horizontal incision was made following the parotid duct, which parallels the superior border of the superficial masseter. The muscle was then dissected away from underlying layer (EPEA) by releasing it from the inferior tubercle of the zygoma and reflecting it caudally.

The EPEA and IPEA are tightly invested with each other and great care must be taken to remove them without causing mutilation. The technique used here began by releasing EPEA from its insertion along the inferior edge of the mandibular angle then reflecting it dorsally. Next, the IPEA was released.
Materials & Methods

from its origin on the inferior edge of the zygomatic arch and reflected ventrally. This exposes zygomatico-
mandibularis which could then be dissected from its origin and insertion on the inferior medial edge of the 
zygoma and the masseteric fossa, respectively.

The Temporalis group consists of the superficial temporalis, deep temporalis and zygomatic 
temporalis. The dissection of this group is made challenging by the narrow space between the zygomatic 
arch, coronoid process and cranium. Superficial temporalis was removed by making an incision around the 
perimeter of its origin and then locating the fascial plane dividing it from zygomatic temporalis near the 
inferior posterior orbital process of the zygoma. Zygomatic temporalis could then be approached superior 
and inferior to the zygoma. Once sufficiently mobilized, zygomatic temporalis was pushed inferiorly through 
this space. Next, deep temporalis was dissected off the cranium and released from its insertion on the medial 
surface of the coronoid process.

The pterygoids are the last muscles to be removed and are completely obscured by the mandible. 
To gain access to the pterygoid insertions, the mandible was divided at the symphysis and retracted laterally. 
Once the mandible is completely removed, the maxillary artery and third branch of the trigeminal nerve 
become visible; these serve as a landmark dividing the medial and lateral heads. Both muscles were then 
released from their origin deep within the suborbital space.

Photographs of each muscle were taken 
both in situ and after removal making sure to orient each specimen with respect to its anterior 
and dorsal position. Each muscle was individually wrapped in a paper towel wetted with preserving fluid, placed in a sealed plastic bag and later weighed using a Gemini-20 portable milligram scale, produced by American Weigh Scales Inc. Origins and insertions were noted during dissection by drawing on a worksheet containing orthographic views of a Trichosurus vulpecula cranium and mandible (fig 14).

V: Digital Muscle Reconstruction in Z-Brush

Using photography and notes obtained from dissection, the muscles were reconstructed digitally in 
ZBrush. This document assumes the audience has an intermediate level of proficiency with the software and only techniques essential to the project will be discussed. Depending on the three-dimensional complexity of
each muscle layer, different modeling strategies were used.

**Technique #1: Sculpting muscles by extraction**

For muscles with complex three dimensional shapes and broad areas of attachment, such as deep temporalis, superficial temporalis, and superficial masseter, reconstruction began by first masking then extracting a new mesh from the surface of the bony anatomy. Working deep to superficial, a mask was applied to a site of either origin or insertion (hold command then click to paint mask on surface). A new mesh was extracted (Tools>Subtools>Extract>Apply; S Smt = 5, Thick = .02) and immediately dynameshed to create even topology. Next, the superficial surface of each mesh was deformed toward one another using the **Move** brush. Once the meshes overlapped, they were merged and dynameshed. Using the **Move** and **Clay Build-Up** brushes, the form was refined until it matched the that of the muscle observed during dissection (fig 15-17).

**Technique #2: Sculpting muscles using primitives**

For muscles with relatively planar forms such as the EPEA, IPEA and zygomatico-mandibularis, reconstruction began by appending a new polymesh 3D sphere object into the model. With symmetry active (Transform>Activate Symmetry>select axis), the **Move** brush was used to flatten the sphere into a disc-like shape which was then transposed to the appropriate location. The form was refined using the **Move** and **Clay Build-Up** brushes.

**Technique #3: Subtracting overlaps using Boolean operations**

After sculpting the general shape of each muscle layer, several Boolean operations were performed to eliminate overlaps between layers of adjacent meshes. This step was crucial to facilitate ease of assembly and disassembly of muscle layers in the physical model. A dedicated tool for doing so was created by duplicating the cranium and mandible subtools (Tools>Subtools>Duplicate) then trimming off non-essential portions of the geometry using the **Trim Curve** brush. A + 0.002 offset of each mesh was then created using the extract function (Tools>Subtools>Extract>Apply) which would allow a slight tolerance of negative space between various parts (fig 18). Both new extractions were renamed, then the mesh used to create them was deleted. Anytime a Boolean subtraction of bone from muscle was needed, either of these meshes could be duplicated and used to do so without the risk of accidentally deleting the original subtools of the bony anatomy.
Materials & Methods

Figure 15. Masked area of zygomatico-mandibularis insertion (A). New subtools (arrows) created after using extraction function (B). Overlapping meshes after deformation (C). Resulting mesh after merging and retopologizing with dynamesh (D). Refined general shape of muscle (E). Muscle as viewed through bony anatomy (F).

Figure 16. Subtool menu indicating new subtools created from extraction (arrows).

Figure 17. Extract menu with settings used. (S Smt = 5, Thick = 0.02).
Materials & Methods

VI: Mass evaluation in SolidWorks

SolidWorks is a parametric 3D solid-modeling software used in engineering and product development industries. ZBrush is marketed toward artists and does not contain tools for evaluating physical properties of models such as mass and volume. The process of measuring the mass of the reconstructed musculature was highly iterative as each mesh had to be repeatedly measured, refined, re-exported and re-verified. Once accurate volumes were achieved, textural details indicating fiber direction were added after which one final mass verification was performed.

The first step in mass evaluation is to export a separate STL for each ZBrush subtool. SolidWorks however, is not designed to handle quadrangular meshes, those with large numbers of polygons or any surface with unclosed contours. Using the decimation master function within ZBrush (**ZPlugin>Decimation Master**), each subtool was converted to a triangular mesh with a significantly lower poly count. Depending on the number of active points, a setting from 10-20% was used to achieve approximately 5,000 total active points per subtool. An active point count higher than 10,000 was found to be inefficient to work with. The steps involved in decimation are as follows:

1. Save the ZBrush project with a new name.
2. Set decimation percentage (this is the percentage of total points that will remain).
   - Select Preprocess Current.
   - Select Decimate Current.

Figure 18. Left cranium (transparent) and offset subtool (opaque) with zygoma removed (A). Left mandible (transparent) and offset subtool (opaque) (B). Offset left zygoma (C). Close up of previous view (D).
Materials & Methods

Once decimation was complete, each subtool was exported as an STL (ZPlugin>3D Print Exporter). The steps involved in exporting STL files from ZBrush are:

3. Change units (in this case, millimeters (mm) were used).
   - Select Update Size Ratios.
   - Select Visible, and make sure only the subtool targeted for export is visible.
   - Under Advanced options>>>>, turn off Textures and Colors.
4. Near the top of the menu, select STL. ZBrush will export the file and ask for save information.

Next, the STL files were imported into SolidWorks. Opening STL files in SolidWorks is relatively straight forward. In the Open dialog box, the file type is changed to STL. Above this drop down menu is a button titled Options. Here the import type was set to Solid, and the file was opened in the modeling window. To measure the mass, the Mass Properties icon was selected from the Evaluate tab on the horizontal tool bar at the top of the screen. A dialog box opens where Options was selected allowing one to input custom settings. The Length, Mass, and Per unit volume were set to millimeters, grams and milliliters, respectively.

Under Material Properties, the density was set to 1.06 g/ml (Murphy, 1974) and the Accuracy level left at Lower (fig 19). The process of attaining an accurate mass for each muscle required several iterations of sculpting, exporting, and re-verifying, a total working time between four to six hours.

![Figure 19. SolidWorks part window (right) with enlarged view of Mass/Section Property Options menu (left). Not all text intended to be read.](image)

An important consideration when evaluating muscle mass in SolidWorks is the unavoidable discrepancy that occurs wherever material thickness in the specimen is too thin to translate into the physical model. Areas composed almost entirely of connective tissue, for example, the midline cranial attachment of
materials & methods

Superficial temporalis, were locally overbuilt to add structural stability. While such areas have an insignificant contribution to the overall mass in the dissected specimen, the additional material drastically altered the values in the reconstruction. The solution to this involved use of extruded cut features in SolidWorks to trim them away and record a mass value before and after the operation (fig 20).

Adding muscle texture

After mass verification, textural details indicating fiber direction and locations of connective tissue such as tendons and fascial sheaths were added (fig 21). Starting with the Clay Buildup brush, a default square alpha and Z-Intensity setting from 10-15, directional lines were alternately added and subtracted on the surface and then smoothed to create a first and second level hierarchy of texture. The next level of detail involved use of the Damien Standard brush with a default Z-Intensity of 25 to sculpt fine lines between select areas of muscle fibers. Finally, the Rake brush was used with a default alpha and a Z-Intensity between 8 and 10 to sculpt the appearance of very fine lines to indicate areas of tendon and fascia. Adding textural detail to the muscle was important in communicating fiber direction, however, the process did change the volume of the subtool slightly and re-verification of each mesh was required after completion.

VI: 3D Printing

The process of readying the ZBrush file for three dimensional printing involves several steps to account for inherent cost and manufacturing constraints. The main driver of cost is the volume of structural and support material consumed. Several steps were taken to mitigate this. First, use of structural material was reduced by retaining the negative space of the brain cavity and hollowing out the nasal passage (due to significant noise, this area was filled solid during the segmentation process in Horos). Second, both cranium and mandible were split at the midline and printed in half. This created a broad, flat surface to lay on the printer bed and greatly reduced the use of support material. Finally, where possible, subtools were rearranged...
Figure 21. Primary layer of texture added with the Clay Build-Up brush (A), then smoothed (B). Secondary layer of texture using a slightly smaller brush size (C), then smoothed (D). Creating creases in select areas with the Damien Standard brush (E). Finest level of detail, Rake brush used to convey connective tissue near origin (F).
Materials & Methods

in a configuration such that their structure took the place of support material. For example, the pterygoids were repositioned within either the left or right brain case (fig 22).

Figure 22. Arrangement of select subtools for printing first prototype. Right cranium and mandible have been split (see Step 1, below) and were fixed together with posts. Superficial temporalis and zygomatico-mandibularis offset from surface with medial pterygoid repositioned inside braincase of right cranium (arrow).

Step 1: File Preparation

Splitting the cranium and mandible was performed by duplicating each subtool, and then subtracting away the non-desired half using a polymesh 3D cube (fig 23). Because of the complex internal geometry of the cranium, simpler methods such as using the “slice curve” brush followed by a “close holes” operation produced undesirable results. The steps involved in splitting these two subtools are outlined below.

1. Append a new polymesh 3D cube into the model (Tools>Subtools>Append).
2. Use the Move Transpose tool to resize the cube approximating the proportions of the targeted subtool
   •  turn on polyframe mode with lines
   •  with Move Transpose selected, click on any point on a face of the cube
   •  rotate the view to be parallel to the direction of the transpose line
   •  hold Shift and click on the center 3rd ring of the transpose line to unidirectionally scale the cube while holding the position of that face
   •  repeat this in other directions until desired shape is reached
3. Move the cube subtool so that is just overlaps the midline of the bony anatomy, then duplicate and mirror the new subtool to the opposite side (Tools>Deformation>select appropriate axis>Mirror)
   •  Increase the scale of the duplicated cube making sure not to change the position of the face on the midline
   •  Use Dynamic Subdivision to generate additional topology (Tools>Dynamic Subdiv>Q Grid = 0; Flat Sub = 2; Smooth = 0>Apply), delete lower subdivisions (Geometry>Del Lower) then Z-Remesh both cubes.
   •  Duplicate the larger subtool and use it to Boolean subtract material away from the first cube.

The midline face of each cube will be perfectly coincident with one another.
4. Duplicate each cube subtool such that there is a "set" for both cranium and mandible.
   - note: it is helpful to rename each cube according to which side they will be removing material from, i.e: right cube is renamed “RT CUBE CUT.”

5. Duplicate the cranium and mandible subtools.
   - note: it is helpful to rename the cranium and mandible subtools according to which side will remain after subtraction, i.e.: one cranium subtool renamed “LT CRANIUM”, other renamed “RT CRANIUM”

6. Use cube subtools to Boolean subtract a side of corresponding cranium/mandible subtool.
   - i.e: RT CUBE CUT subtool subtracts from LT CRANIUM subtool.

_Cranium and mandible should be split into halves, each having a face coincident with the sagittal plane._

After splitting the cranium and mandible, each subtool was decimated then exported as an STL using the same workflow described in the previous section. The decimated file was saved separately to preserve the higher resolution, quad-based mesh in the likely possibility that it would undergo further refinement. Within the decimated file, individual subtools were rearranged to minimize use of support material.
Materials & Methods

Step 2: Processing STL files in MeshMixer

Prior to printing, files must be checked for unclosed contours and resolved if any should occur. Autodesk Meshmixer is a free downloadable software that can be used to pre-process triangular meshes for 3D printing. Each STL file or assembly was imported into Meshmixer and inspected for errors (Analysis>Inspector) (fig 24). The process of using Dynamesh within ZBrush should eliminate most issues, however, portions of the cranium and mandible contained overlapping polys that were resolved using the Auto Repair function. The repaired mesh is then exported as an STL (File>Export) and saved over the original file.

Step 3: Importing into Stratasys Objet Studio

Translation of the digital model into physical form was executed using a Stratasys Object 260 Connex 3 multi-material 3D printer, housed at the Johns Hopkins Carnegie Center for Surgical Innovation. The printer builds parts by depositing successive layers of UV cured resin on a metallic plate. It has a X, Y, Z resolution 600, 600, 1600 dpi respectively and an accuracy of 20-85 microns for features less than 5 cm in height (http://www.stratasys.com/3d-printers/design-series/objet260-connex3). The Objet Studio software is very intuitive. STL files were inserted, automatically placed (Placement), validated for unclosed contours (Validate) after which an estimate was generated (Estimate) (fig 25).

VII: Creation of Assembly Features

Because the physical model would require somewhat skillfull handling of the many individual components, the effectiveness of it as a teaching tool would be reduced if it was burdened by a high intrinsic
cognitive load Sweller, 1994). Therefore, the assembly features needed to be well thought out. Assembly features were created entirely in ZBrush using various hard surface modeling strategies. SolidWorks engineering software was investigated as a potential tool as well, however, it is not designed to handle large amounts of mesh data and the workflow was found to be inefficient. An additional benefit of using ZBrush is that it allows more freedom for the designer to create shapes for assembly features that appear aesthetically native to the model. For example, a press fitting could be made to follow the edge of area of insertion for a muscle, thus tying its shape to the information needing to be conveyed. Three strategies for assembly features were investigated and are outline below. A total of two prototypes were created to allow iterative refinement before building the final model. Photographs of the prototypes can be viewed in the Results section of this document.

*Strategy 1: self-retaining parts*

If two parts had interlocking geometry that prevented passive disengagement from one another, the part was determined to be self-retaining and no additional mechanical features were created. This was the case for Deep temporalis, as seen in Figure 26.
Materials & Methods

Strategy 2: Press fittings

If a two parts were not able to be self-retained, additional geometry was added in the form of positive and negative shapes to create interlocking geometry. Most often this took the form of a boss or rib that mated with a pocket on the opposite part (fig 27).

Strategy 3: Magnetic fastening

When the addition of a press fitting did not fully secure one part to another, small neodymium iron-boron rare earth magnets (https://www.mcmaster.com/#standard-magnets/=16u4yq6) were embedded into the surface and secured with cyanoacrylate adhesive (fig 28).

A: Creating Press Fittings

The first step in creating the positive feature of the press fitting was to duplicate the subtool it will be added to (Tools>Subtools> Duplicate). Next, the camera view was oriented normal to the surface targeted for feature creation. Most often this was an orthographic view. The Slice Curve brush with Lasso stroke (Control-Shift-select brush from palette) was used to make a new polygroup from the surface (fig 29-A). The new polygroup was isolated (Control-Shift-click on portions of mesh to hide) and the hidden portion of the mesh deleted (Tools>Geometry>Modify Topology>Delete Hidden) along with any parts of the new polygroup deep to the outer surface (fig 29-B). The Slice Curve brush will often leave facets of polys along the cut edge of the new polygroup. The Lasso Tool was used to hide the facets which were then deleted. Next, the polygroup was retopologized using ZRemesher (Tools>Geometry>ZRemesher) with the Same setting selected, keeping the exact number of poly’s as the previous mesh while creating uniform topology (fig 29- C, D).

The retopologized surface was then flattened using the Planar Brush (fig 29-E, F). By clicking on a relatively flat region in the mesh and moving over the surface, polys above the group normal will be aligned.
Figure 29. Shape of new polygroup made from duplicated mandible subtool (A). Resulting mesh after hiding and deleting remainder of duplicated mandible (B). Topology before (C) and after (D) removal of facets and ZRemesh operation. Before (E) and after (F) flattening using the Planar brush. Extruded shape using ZModeler brush with Qmesh action and Flat Island target (G). Position of extrusion on original mandible subtool (H).
Materials & Methods

to the same plane of the poly originally clicked. Holding alt modifies the brush function so that polys below the normal will be aligned. Using the Planar brush takes some practice and based on a polys distance from the region clicked, several passes may be needed to create flat topology. Once flattened the surface can be used to create a linear extrusion with a smooth edges and no undercuts or tapers that would adversely affect user interaction.

Extrusion of the flattened shape was accomplished with the ZModeler brush. Hovering over a poly and pressing spacebar will open the ZModeler menu. Qmesh was selected from the poly actions menu, the target area set to Flat Island and the modifiers left at their default settings. Releasing spacebar exits the ZModeler menu. An extrusion can then be created by hovering over a poly and clicking and dragging a desired distance (fig 29-G) making sure not to exceed the outer wall of the counterpart mesh that will mate with teh extrusion. A second extrusion was then created in the opposite direction to provide enough overlapping geometry to allow it to be merged with its parent (fig 29-H). Prior to merging, the entire extrusion was retopologized using the ZRemesher (settings: Same, Adaptive) and a + 0.002 extraction was created (Tools>Subtools>Extract) to later Boolean subtract a cavity from the subtool that the extrusion is meant to mate with. Finally, the positive extrusion was merged with its corresponding subtool and then dymesched to create a single continuous part.

B: Creating Pocket Features for Magnets

Boolean operations were used to create pockets allowing cylindrical rare-earth magnets to be embedded into the model (fig 30). The pockets needed to be dimensionally accurate, however, the ability of ZBrush to build parametrically accurate shapes is limited and highly unintuitive. A range of magnet sizes were investigated. The height and diameter of magnets were measured with a pair of digital calipers so they could be modeled in Cinema 4D to exact specifications. Next, a clearance model was made to use for Boolean subtractions where magnets were to be embedded. Each clearance model accounted for an additional 0.25 mm in diameter and 1.0 mm in height. A single circular face of the clearance model was extruded further which left an edge to use for alignment during the subtraction process. The clearance model was exported as an STL then imported into the ZBrush model of the reconstruction.
VIII: Surface Patterns for sites of Origin and Insertion

The right half of the model was intended to show patterns of origin and insertion for each muscle of the masticatory apparatus. To accomplish this, a pattern was created in Illustrator and exported as a PSD to use as an Alpha within ZBrush. The pattern was designed as an offset array of tightly spaced circles that would be embossed on the surface to indicate an origin and debossed to indicate an insertion (fig 31).

For increased control over the appearance of the O/I patterns after they are made, individual layers were created for each O/I on both the cranium and mandible. First, a new layer was created (Tool>Layers>New Layer) (fig 32-A1) and assigned a name, making sure that Record is activated (fig 32-A2). Second, the area targeted for patterning was masked and then inverted (fig 33-A, B). Third, the alpha was imported (Brush Alpha>Import), loaded into the Standard Brush with the Drag Rect stroke, then
Materials & Methods

Figure 32. Layers palette showing deep temporalis layer set to record (A2), new layer button (A1), and Bake All button (A3). Deformation palette with Offset set to -0.75 (B). Alpha palette (C) indicating pattern (C1), inverse button (C2) and tiling adjustment sliders (C3).

Figure 33. Creating origin and insertion patterns on right cranium. Masked area for Deep temporalis origin (A). Inverted mask (B). Surface targeted for patterning is raised with using Deformation>Offset tool (C). Origin pattern on surface after using Standard brush with Drag-Rect stroke with alpha pattern (D).
modified by increasing the H and V Tiling to a value of 10 (Alpha>Modify>H Tiling, V Tiling) (fig-32, C3). To create a more distinct boundary for the origin or insertion area, a slight offset was created using the deformation tool (Tools>Deformation>Offset>select axis) and the Move brush (fig 32-B; fig 33-C). The model was positioned in a view normal to surface and the pattern was dragged to a desired size (fig 33 D). Depending on the complexity of the surface, the pattern may distort based on the view. Several attempts may be necessary to achieve the desired appearance, adjusting the view as necessary. Once satisfactory, Record is turned off and the Intensity of the appearance was adjusted (this is much like adjusting the opacity setting of a layer in Photoshop).

For areas of the model with complex surfaces, such as the insertion site of the medial pterygoid, using the Standard Brush with a Drag Rect stroke to apply the pattern produced undesirable results. Instead, the Track brush was used in conjunction with the Alpha pattern. This brush does not appear within the default brush menu and must be loaded from Lightbox (”,”>Brush>Tracks Folder). The pattern is created by clicking and dragging on the surface in the same way one uses a sculpting brush to affect topology. It should be noted, however, that H and V-Tiling must be set to a value of “1” for this brush function. While the Track brush was more effective for certain areas than the earlier approach, a small amount of distortion still occurred and some manual clean-up was necessary. Using layers within ZBrush prevents general sculpting of the subtool. This is resolved by creating additional layers or the patterned layers can be “baked” into the model (Tools>Layers>Bake All) (fig 32-A3). To preserve editing of the layers, a separate file was saved before baking. Once baked, general sculpting can resume. The Damien Standard brush was used to tighten edges around the perimeter of each site of origin and insertion.

IX: Digital Renderings

Using the GoZ functionality within ZBrush, a version of the digitally reconstructed skull and musculature without assembly features was exported to Cinema 4D for the purpose of creating photorealistic renderings. Before exporting, however, several steps were taken to create texture maps which would embed color information onto the polys of each muscle subtool. The cloned PSD file of the texture map was edited in Adobe Photoshop to add detail to the muscle fibers and connective tissue. Color differentiation between dentition and bone was also desired but, unfortunately, the geometry of the bony anatomy was not compatible with the UV Map functionality. Masking was used to separate the dentition and cranium/mandible into polygroups (Tools>Polygroups>From Masking), and then their own respective subtools. They could then be rendered different materials within Cinema 4D.
Figure 34. Screen captures of the UV Master and Texture Map palettes within ZBrush. Numbered arrows indicate order of steps outlined in text as well highlight the counterintuitive design of the interface.

Figure 35. Cloned Deep temporalis subtool with control painting applied (A). Display of seam after performing an Unwrap (B). Subtool with polypaint applied (C).
Step 1: UV Maps

Under Tools>UV Map, the UV Map Size was set to 2048. Next, using the UV Map palette (Zplugin>UV Master), Work On Clone was selected, the isolated subtool was unwrapped (UV Master>Unwrap) and the seams were checked for proper placement (UV Master>CheckSeams) (fig 34). If the seam traversed an area of the mesh in an undesirable way, Enable Control Painting was used to try and redirect its path. Selecting Protect (UV Master>Protect) and then painting on the model (default color is red) instructs the software to avoid placing the seam in that location (fig 35-A, B). Using Attract (default color is blue) instructs the software to do the opposite and attempts to place the seam in the painted location. For subtools with more complex geometry, several attempts were necessary to create seams that followed a desirable path, such as on a non-visible face or along an edge that would serve as a useful landmark during refinement of the texture map in Photoshop. Once a seam was deemed satisfactory, the UV map was copied (UV Master>Copy UVs) and then pasted (UV Map>Paste UVs) onto the corresponding subtool in the original file.

Step 2: Polypainting and Texture Map creation

After UV’s were mapped onto the surface, each muscle subtool was polypainted (fig 35-C). With polypainting active (Tools>Polypaint>Colorize) the subtool was filled with a base color (select color then goto Color>Fill Object). Next, using the Standard Brush with Zadd and Zsub deselected and Rgb turned on, areas of connective tissue were generalized using a light grey color and creases between muscle fibers were painted in dark red (texture maps appear flat within Photoshop and denoting location of the creases improved the workflow when adding further detail). Lastly, the texture map was created from the polypaint information (Tools>Texture Map>New From Polypaint), cloned to the texture selection box on the left side of the screen (Texture Map>Clone Txtr), then exported and saved as a PSD file.

Step 3: GoZ Export to Cinema 4D

Unlike most interactions within ZBrush, the transfer of mesh data to Cinema 4D is remarkably easy and intuitive. First, the application preference for the GoZ exporter was set to Cinema 4D (Preferences>GoZ>Path to Cinema 4D). Next, each subtool was isolated and exported (Tools>GoZ) into a single Cinema 4D file.

Step 4: Scene Rigging in Cinema 4D

When using the GoZ export function, ZBrush automatically creates a material with an embedded texture map for each subtool. Before adding additional detail to each muscle, the PSD texture maps, lighting
and cameras were rigged, then scenes were composed for each view using the Take functionality within Cinema 4D. Establishing the scene beforehand streamlined the workflow of adding textural detail to muscles as well as any other changes to the model.

**Lighting**

A main area light was positioned to the upper left of the model, the color was changed to a subtle warm hue, the intensity set at 100%, soft shadows were turned on and the falloff set to Inverse Square-Physically Accurate (goto light Object Manager>Details>Falloff>Inverse Square (Physically Accurate)). A second area light was placed to the lower right, the color was changed to a subtle cool hue, the intensity set to 50, soft shadows were turned off and the falloff also set to Inverse Square-Physically Accurate. An omni light set an 50% intensity with Ambient Illumination turned on (goto light Object Manager>General>check Ambient Illumination) was added to the scene, brightening the overall appearance of the model. This technique achieves the same result of using global illumination, however, does not impact render times. Lastly, a third area light was added having a neutral hue, a 50% intensity, shadows turned off and an Inverse Square falloff to locally fill areas of the model that were in shadow such as the pterygoids when viewed from a medial or ventral position (fig 36).

![Figure 36. Screenshots of lighting rig within Cinema 4D: main area light (A), primary fill light (B), secondary fill light (C) and ambient light (D).](image)

**Materials**

All muscle materials took advantage of the Color, Luminance, Reflectance and Bump channels. The GoZ export automatically generated a material with an embedded texture map for each muscle (fig 37). Within the Color Channel, the Texture was set to Layers. Clicking on the adjacent image icon brings up another menu where the cloned copy of the texture map can be loaded by clicking on the Image button. The blending mode for each layer was left at Normal. Next, the Luminance channel was set with Brightness at 5% and the same cloned texture was loaded into the Texture tab. Next, the Mix Mode was changed to Add and Mix Strength set to 10%. Within the Reflectance channel, the Type was changed to Beckmann, Attenuation to Additive, Roughness set at 6%, Reflection Strength at 1% and Specular Strength at 5%.
Materials & Methods

Lastly, the appearance of subtle irregularity in the muscle surface was achieved by adding a Bump channel. The Texture was set to Noise and the Hama noise pattern selected with the following settings: Global Scale - 5%, Low Clip - 20%, Contrast - 80%.

Cinema 4D’s take system automates the rendering process by setting up multiple scenes within the same file. Takes were created for lateral, medial, dorsal and ventral views (Take Manager->File->New Take) and several child takes were created within each view that progressively turned off layers of muscle groups (right click on take->New Child Take). All takes below the top level take will inherit the properties of its parent unless overridden. To customize the view within a take, Lock Overrides must be activated (Take Manager->Override->Lock Overrides). Next, the new take is selected and Auto Take is turned on. Parameters governing the scene such as individual model position, visibility, camera selection and lighting attributes were set for each take. Once satisfactory, Auto Take was turned off. Renderings of each take were automatically generated by selecting Rendering all Takes to PV (fig 38).
Materials & Methods

Step 5: Texturing in Photoshop

Adding detail to the cloned texture map of the musculature was performed in Adobe Photoshop via pathways embedded within the Material Editor of Cinema 4D. Within the Color channel, the Texture was set to Layer. Next, clicking on Layer opens a dialog window and by clicking the Image button, the cloned texture (saved as separate files out of ZBrush earlier in the workflow) was added. The added textures are easily edited by clicking the image icon for that layer and selecting Edit Image. Cinema 4d will automatically open the file within Photoshop. When the addition of detail within Photoshop was complete, the file was saved and the texture was then updated in Cinema 4D by clicking Reload Image.

![Figure 39. Texture map before (left) and after (right) addition of detail.](image_url)
RESULTS

Using both the DICOM dataset of hard tissue structures and volumetric information acquired from dissection, a digital reconstruction of the masticatory apparatus of the phalangeroid possum, *Trichosurus vulpecula*, was created in ZBrush. Both 3D printed model and flat illustrations were created from the digital reconstruction with the goal of improving communication of spatial relationships and other details of phalangeroid chewing musculature.

I: Design Criteria

After the summary of responses was analyzed, the following design criteria for the model were derived.

1. The model must be accurate with respect to anatomy, overall dimensions, and appearance.
2. The model must clearly demonstrate the position and layers of each muscle group.
3. The model must clearly demonstrate the origin and insertion of the layers of each muscle group.
4. The model must demonstrate the fiber direction of each muscle.
5. The model must give an accurate representation of the relative mass and volume of each muscle with respect to each other.

II: Flat Illustration

Flat illustrations of the bony anatomy clearly describe anatomical landmarks important to understanding origin and insertion of the muscular anatomy. Three dimensional photo realistic still renderings of the digital model demonstrate muscle layers in flat space as well as associated structures important when conducting dissections. As with the physical model, the illustrations rely upon real data and provide a highly accurate representation of muscle volume, shape, fiber direction and sites of origin and insertion.
RESULTS

DORSAL VIEW

Figure 40. Anatomical landmarks of the cranium, *Trichosurus vulpecula*.
Figure 41. Anatomical landmarks of the mandible (*Trichosurus vulpecula*).
Figure 42. Origin and insertion of the Masseter group (*Trichosurus vulpecula*).
Figure 43. Origin and insertion of the Temporalis group and Pterygoids (Trichosurus vulpecula).
III: Digital Reconstruction

A: Physical Model

Two versions of the digital reconstruction were created. One model was designed for 3D printing and contained local thickenings of tendinous attachments as well as mechanical features to allow the user to add and remove muscle layers. The physical model provides the audience with a multi-sensory tactile experience from which they can learn about the spatial relationships and other aspects of the phalangeroid masticatory apparatus. The model can be used as a stand-alone didactic tool or in conjunction with 2D assets to learn about phalangeroid anatomy. Additionally, both can be used to draw conclusions about the relationship between phalangeroids and Lemuriformes.

Figure 44. Photograph of the final physical model in assembled form.
Results

Figure 45. Photographs of the final model, caudal (top) and disassembled (bottom).
Results

Figure 46. Photography of the first (top) and second (bottom) prototype.
Results

B: Virtual Model

The second version of the digital reconstruction was produced without localized thickenings or assembly features in order to accurately represent muscle anatomy in photo realistic renderings. Additionally, this version could be used to create assets such as animations and static two dimensional images for use in interactive media designed for educational or research purposes.

IV: Anatomy of Musculature

The Masseter group is most superficial of the jaw adductors and contains four layers representing an 38.2 % of the total mass and weighs 2.5 grams (g). From superficial to deep the layers are superficial masseter, external part of the external adductor (EPEA), internal part of the external adductor (IPEA), and zygomatico-mandibularis. Superficial masseter is the largest of these and represents 21.2 % of total mass and weighs 1.36 g. Its origin occurs on a relatively small patch on the anterior zygomatic tubercle and inserts broadly on the posterior surface of the angular process and ramus of the mandible. From caudal to rostral the fibers are oriented in a slightly oblique fashion dorsally, indicating its role as a power adductor as well as a protractor of the mandible. The EPEA and IPEA are thin sheet like muscles that are tightly invested with each other. Their origins occur on the inferior edge of the zygomatic arch, caudal to the anterior tubercle and insert on the antero-lateral edge of the ramus. The fibers are oriented vertically from ventral to dorsal, indicating a role in adduction. Together they represent 12.8% of the total mass and weigh 0.824 g. Zygomatico-mandibularis, another relatively sheet-like muscle and the last layer of the masseter group, weighs only 0.27 g and represents 4.2 % of the total mass. Its origin is medial and adjacent to that of IPEA, however, it has a broad insertion on the lower lateral surface of the coronoid. The fibers of zygomatico-mandibularis are oriented in parallel with EPEA and IPEA.

The Temporalis group is the largest of the jaw adductors consisting of 43.2% of total mass, weighing 2.78 g, and consists of three layers: superficial temporalis, deep temporalis and zygomatic temporalis. All three muscles function as powerful elevators of the mandible. Collectively and individually, the shape of the temporalis group is more complex than either the Masseter group or Pterygoids. Superficial temporalis represents 10.6% of the total mass and weighs 0.68 g. The fibers run rostral to caudal in a largely horizontal plane before turning ventrally to insert on the rostral edge of the coronoid. Deep temporalis consists of 20% of the total mass, and is the second largest adductor after superficial masseter weighing 1.30 g. It has a broad area of both origin and insertion on the dorsum of the cranium and medial face of the coronoid, respectively. Zygomatic temporalis represents 12.4% of the total mass and weighs 0.80 g. It has a broad origin on the medial surface of the zygoma and insertion on the upper-lateral surface of the coronoid.
Results

The pterygoids are the smallest muscle group representing 18.6% of the total mass and have a combined weight of 1.20 g. The medial pterygoid is the larger of the two muscles at 13.3 percent total mass and weighing 0.86 g. It originates on the lateral surface of the pterygoid plate and inserts broadly on the medial surface of the mandible within the pterygoid fossa. Its fibers run oblique in both dorsal-ventral as well as lateral to medial planes. The lateral pterygoid has a narrow band of origin superior to the edge of the lateral pterygoid plate and a small insertion just above its medial counterpart and below the temporomandibular condyle. Its fibers run obliquely from medial to lateral while the muscle itself lies on a horizontal plane. Lateral pterygoid is the second smallest muscle of the jaw adductors at only 5.3 % total mass and weighing 0.34 g. Both lateral and medial pterygoid function to protrude the jaw and likely have a role horizontal translation.
Figure 47. Musculature, superficial layers.

**Results**
Figure 48. Deep layers of the Masseter group.
Figure 49. Deep layers of the Temporalis group.
Figure 50. Position of the Pterygoids.
Results

V: Workflow Documentation

Documentation of the workflow is presented as two parallel paths: physical and digital (fig 51). In the beginning these paths are not mutually exclusive. For example, muscle reconstruction cannot start before completing dissections. Timing was such that the latter step did not begin until January 18th, leaving a scant 62 days to complete the project. Likewise, neither version of the digital model could be finalized until volume verification was complete.

The paths converge halfway through during the iterative phase of prototyping and volume verification, after which the two halves separate, allowing some measure of multitasking while the final prototype is being produced. Omitted from the workflow are the many dead ends and failed attempts encountered while experimenting with various techniques to achieve the project goals.
Figure 51. Workflow diagram separated into digital and physical tasks.
VI: Asset Referral

Access to the 2D assets created for this thesis is available at www.rebackbiomedicalmedia.com or by contacting the author at nicholasreback@gmail.com. The author may also be contacted through the Department of Art as Applied to Medicine at Johns Hopkins University School of Medicine or via the department website www.hopkinsmedicine.org/medart.
**DISCUSSION**

It can be said without much disagreement that the success of a medical illustrator is limited by their breadth of scientific knowledge and depth of artistic ability. The primary personal goal of this thesis was to not only increase the depth of my technical ability with a wide range of artistic tools, but also expand my knowledge of scientific subject matter. The secondary goal, driven by more than a decade of professional experience, was to select a preceptor with whom I could have a positive working relationship, a factor I deem as a core constituent of the most successful projects of my past.

**II: Production Goals and Challenges**

Production goals within the scope of the project included the use of a variety of tools and techniques to compose a clear and intuitive narrative about Strepsirrhine-phalangeroid convergence as well as the masticatory apparatus of the latter. It is my hope that resources presented here will improve the ability of the audience to understand possum morphology, ecology and biology as well as draw meaningful comparisons to lemuriformes and, eventually, conclusions about primate origins. Documentation of the workflow will allow third parties to successfully replicate these results with respect to other taxa. The 3D applications employed are powerful asset creation tools in their own right. In combination, however, the number of possible pathways to success is overwhelming and navigating this required a significant amount of trial and error.

The most challenging aspect of this project involved familiarization with primate and metatherian evolutionary biology, an area of scientific study with which I had no prior knowledge. In the months prior to the first dissection, many hours were spent conducting a broad literature in order to firmly grasp concepts in evolutionary biology, relevant terminology, possum ecology, hypotheses of primate origins and general primatology. As is often the case, the project was made more challenging by uncontrollable factors such as schedule delays, procedural dead ends and cost constraints with respect to manufacturing the physical model. That being said, organization and time management were powerful assets in remaining flexible in the face of adversity while maintaining forward momentum. For example, the digital reconstruction could not proceed before dissections were completed and so literature reviews, software training, preliminary 2D asset creation and preparation for qualitative user interviews proved to be an effective time saving strategy.
II: Digital Workflow

A: ZBrush

Working in ZBrush consumed the greatest proportion of the time during the project. While this was anticipated, the most inefficient periods were largely due to struggles with the unintuitive nature of the user interface. The design does not mirror the UI of more ubiquitous asset creation applications such as Adobe’s Creative Suite or standard packages from Microsoft, and its layout makes it difficult for one to form a mental picture of the location of many commonly employed tools. The task of learning ZBrush involved many hours watching tutorials, taking notes and practicing new techniques within and outside of the project. Ironically, the most useful resource with respect to skill development came from instructional videos found on the manufacturers website: www.pixologic.com/zclassroom/. These are well structured, chunked out into reasonable lengths of time and can be bookmarked for later viewing by creating Pixologic profile.

The functionality of ZBrush is targeted toward artists and the program itself offers little in the way of parametric controls like those found in engineering packages such as SolidWorks or even that of animation software like Cinema 4D. There were many moments of doubt as to whether the model was at the right scale. The model needed to be exported to Cinema 4D, SolidWorks, and in one case Avizo to ensure the scale was in fact correct. Sizing of assembly features like press-fittings and pockets for magnets was also problematic and prone to error.

B: Cinema 4D

Cinema 4D is a robust 3D modeling and animation program within many embedded tools that make the production of still images fast and forgiving. While the UI is not as unintuitive as ZBrush, there were still challenges inherent to identifying the best tools for the task at hand. For example, there is not commonality between either software package with respect to hot key function and assignment. In a similar fashion to learning ZBrush, web-based tutorials, particularly those on greyscalegorilla.com, were especially useful. Unfortunately, many of these are quite long and may contain a lot of irrelevant content.

III: Physical Workflow

A: Dissection

Dissection was assisted by Dr. Jonathan Perry at the Center for Functional Anatomy and Evolution at Johns Hopkins University School of Medicine. A total of four Trichosurus vulpecula specimens were dissected, however, dental analysis of two specimens revealed they were juvenile and would adversely affect the data on
Discussion

Muscle mass. The data used for reconstruction was therefore based on only two adult specimens, a male and female of almost identical size. Dissection of the muscles was performed with caution and individual layers were removed in whole without mutilation, however a larger sample size from 3-5 specimens would have been preferred.

B: 3D Printing

With any project involving a digital to physical asset transition, cost must be taken into consideration. The cost associated with 3D printing is based on platform type and material use. The platform used for the project was comparatively expensive due to its resolution and ability to print multiple colors and materials within a single run. Significant savings were achieved by reducing scale, printing in single material mode when possible and employing packing strategies to decrease material use, particularly for the support. For example, only the lateral half of the cranium and mandible was printed for the first prototype at 150% actual size. The second prototype needed to be full scale to allow test fitting of magnetic fasteners as well as user interaction. The scale was increased to 200% and both halves of the cranium and mandible were printed, but only a single material was used and STL files were strategically assembled to significantly reduce the consumption of support material (i.e.: the pterygoids were relocated to a position within the braincase of either half). If both prototypes were printed in full color and at the same scale as the final model it would have added over $500 to the cost of project.

A 3D printer is often a shared resource, and this project was no exception in this regard. Depending on the type and number of jobs in the queue, a print may experience delays from several hours to days. Additionally, the process of 3D printing is not analogous to production of documents. A job requiring a change in material durometer or color requires that the printer undergo an optimization, a procedure that took approximately 2-3 hours. Understanding the printing process and opening a direct line of communication with staff managing the 3D printer, in this case, Juan Garcia and Sarah Chen, is important in setting realistic expectations and reducing frustration.

C: Response to the Physical Model

Due to time constraints the model was not formally tested for the submission of the thesis. Overall response, however, was positive and users expressed enthusiasm at the ability add or remove muscle layers and felt the model helped them to better understand spatial relationships. When asked to assemble the model from scratch, users struggled to understand the order of assembly. Knowing the assembly order beforehand is not a learning objective of the model and so a set of instructions will likely be designed to help direct first-time users through this process.
Discussion

Much effort was expended to ensure accuracy of the model with respect to muscle mass and volume as well as contextual details such as fiber direction, connective tissue, suture lines and dentition. Unfortunately, two of the representative muscles, zygomatico-mandibularis and zygotamis temporalis, could not be made small enough to reflect measurements taken from dissection specimens. It is possible that due to the length of time the muscles were preserved, some decomposition of surrounding tissue took place.
### APPENDIX

#### Interview Response Summaries: Part 1

<table>
<thead>
<tr>
<th>PART I</th>
<th>Respondent 1</th>
<th>Respondent 2</th>
<th>Respondent 3</th>
<th>Respondent 4</th>
<th>Respondent 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Degree Status</td>
<td>PhD/Professor</td>
<td>MS</td>
<td>PhD/Assistant Professor</td>
<td>BS-Anthropology</td>
<td>PhD/Assistant Professor</td>
</tr>
<tr>
<td>Current field of study</td>
<td>Paleontology - early mammals of South America/Caribbean</td>
<td>Primatology - changes in mandibular apparatus of Lemurs through maturation cycle</td>
<td>Studies dition and cranial morphology in strepshirrine primates</td>
<td>Evolution of food in strepshirrine primates</td>
<td>Primate locomotion and its affect on the skeletal system</td>
</tr>
<tr>
<td>Is the study of mammalian chewing muscles important to you work?</td>
<td></td>
<td>Y</td>
<td></td>
<td></td>
<td>Indirectly</td>
</tr>
<tr>
<td>If &quot;yes,&quot; can you explain why?</td>
<td>Understanding a species niche (environment animal lives in, diet, competition); what they eat/how food is processed informs us where they fall in fauna diversity; cranial mandibular chapes; pathology: TMJ possibly caused by missing dentition</td>
<td>How do animals gain ability to feed independently on solid food; transition from milk to solids; helps with behavioral studies, husbandry; compare to juvenile fossil material</td>
<td>chewing muscle function, esp force generation, affects morphology</td>
<td>muscles contract-cause action; size of muscle affects force generation; muscle reconstruction allows understaning of chewing</td>
<td>postcranial purpose is to move digestive/reproductive systems within environment, adapted to gathering food; chewing muscles essential for locomotion, defense and reproduction</td>
</tr>
<tr>
<td>If &quot;no,&quot; can you explain why it is an important subject to study?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>What types of information about chewing muscles are you interested in?</td>
<td>Fiber direction; overall mass, O/I, potential force generation</td>
<td>Fiber direction/length, O/I, PCSA, force production, appearance/penetration; change/time</td>
<td>differences b/w species, relationship to what they eat; size and position of muscles as well as attachments (O/I)</td>
<td>action/direction, force production, active vs nonactive muscle during cycle; area of O/I</td>
<td>biomechanical perspective, PCSA, O/I, penetration angle; activation/EMG data, when muscles are active during cycle</td>
</tr>
<tr>
<td>How do you use this information?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>In what ways is this data typically represented?</td>
<td>line drawings, CT and/or MRI datasets/images, photography</td>
<td>text is most common; drawings of jaw/skull; vector drawing of attachments; 3D pdf export from Avizo</td>
<td>O/I and landmarks used for morphological measurements; force production; measurement of condyle to diiff dental positions</td>
<td>in early phase of research; looking at big picture</td>
<td>N/A</td>
</tr>
<tr>
<td>Can you compare the relative effectiveness of these representations as learning/communication tools?</td>
<td>not effective for communicating complicated movements of chewing exp medial/lateral</td>
<td>text cannot be poorly worded in a paper, but images are not held to same standard; often not good/relevant to area of interest; photos lit poorly; need to appreciate things spatially; helpful to have layers, multiple points of view</td>
<td>2D tools hard to relate different views/levels of dissection</td>
<td>no answer</td>
<td>effective for what they are trying to communicate</td>
</tr>
<tr>
<td>Are there any aspects of studying MCM that particularly difficult to understand?</td>
<td>pterygoids: hidden by mandible, very three dimensional, complicated structure and function; medial lateral movement</td>
<td>dissection: clean removal of muscle from attachment site is challenging; hard to see inside of zygoma; insertions</td>
<td>triangle of support model; muscle layers and their actions; fiber direction; pterygoids - not easy to see</td>
<td>many ways to chew, how will honey structure affect chewing</td>
<td>pterygoids: hidden behind mandible, must be imagined.</td>
</tr>
</tbody>
</table>
### Interview Response Summaries: Part 2

#### Part 2

<table>
<thead>
<tr>
<th>If you could design your own tool for teaching/communicating MCM, what would it look like?</th>
<th>3D virtual skull stripped of all but chewing muscles with ability to simulate chewing motion; prefers learning from a physical model; something I could rotate; fade in/out muscles; animation of chewing</th>
<th>way to visualize tooth complex/pattern of occlusion as it relates to distribution of force; would show how much line of action is moving relative to fulcrum</th>
<th>a virtual model that would allow gathering of physical properties of food; reconstruction of chewing muscles;</th>
<th>detailed virtual model of crania/mandible with chewing muscles attached;</th>
</tr>
</thead>
<tbody>
<tr>
<td>What features do you think would improve the effectiveness of the following as a teaching tool?</td>
<td>Animations showing chewing; muscles light up depending on activation; motion of a single muscle</td>
<td>Show chewing cycle, position of muscles at various points in gape; see muscles in isolation and combined; alter parameters (ie: PSCA) and see effects</td>
<td>See above</td>
<td>See above</td>
</tr>
<tr>
<td>A) 3D virtual model</td>
<td>Accuracy is important; extraneous information not relevant to area of study should be removed</td>
<td>Multiple models with different groups of muscles on them; show fiber direction; presentation</td>
<td>Part of mandible transparent to see how dentition occludes; take on/off muscles; ability to articulate</td>
<td>Ability to test fracture point of food; tooth material similar to real teeth; articulated jaw within limits</td>
</tr>
<tr>
<td>B) 3D Physical model</td>
<td>Have you ever used a 3D virtual or physical model as a teaching/communication tool in the past?</td>
<td>Laser scanning of dentition, tooth landmarks, compare sets of data; 3D prints (bones/skulls) used to teach students</td>
<td>Real specimens; Google anatomy; Anatomia model of eye movements</td>
<td>Physical specimens; models used to teach undergraduates (ie: pelvic floor); have not used a lot of virtual models</td>
</tr>
<tr>
<td>If “yes,” can you give examples?</td>
<td>Learning from a 3D model is multi sensory; see and touch, paleontology is tactile; easier to make comparison with physical specimen</td>
<td>Physical models/real specimens help concepts click.</td>
<td>Physical model can be shared among greater number of students; physical model is more “active”; CT has ability to zoom in on details; set landmarks and measure distance; doesn’t damage like a real specimen</td>
<td>Little substitute for ability to see/touch; value of dissection; description would not be efficient;</td>
</tr>
<tr>
<td>Describe how the model was useful to you?</td>
<td>Where the anyways the model was not effective as a teaching or communication tool?</td>
<td>Not many models out there. Current 2D visuals are usually poor quality</td>
<td>Physical model cannot be shared across distance but virtual model can; physical model may not represent variation (become standardized); changes over time not shown; models need to simplify but sometimes go to far</td>
<td>Takes certain amount of practive to use virtual tools</td>
</tr>
<tr>
<td>Where there anyways the model was not effective as a teaching or communication tool?</td>
<td>Muscle/poorly executed photography and/or diagrams; only useful to experienced audience; not to students; area of interest is covered by structures not relevant to study</td>
<td>If &quot;yes,&quot; can you give examples?</td>
<td>If &quot;yes,&quot; can you explain why?</td>
<td>If &quot;yes,&quot; can you give examples?</td>
</tr>
</tbody>
</table>
## Muscle Volume Worksheet

<table>
<thead>
<tr>
<th>IMAGE REF</th>
<th>MUSCLE NAME</th>
<th>SPECIMENS</th>
<th>BASE SCULPT</th>
<th>TEXTURE</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>#256802 (g)</td>
<td>#257805 (g)</td>
<td>AVG (g)</td>
</tr>
<tr>
<td></td>
<td>Superficial Masseter</td>
<td>1.359</td>
<td>1.369</td>
<td>1.564</td>
</tr>
<tr>
<td></td>
<td>RFMA</td>
<td>0.453</td>
<td>0.685</td>
<td>0.569</td>
</tr>
<tr>
<td></td>
<td>LFMA</td>
<td>0.226</td>
<td>0.284</td>
<td>0.255</td>
</tr>
<tr>
<td></td>
<td>Zygomatico-</td>
<td>0.267</td>
<td>0.27</td>
<td>0.2685</td>
</tr>
<tr>
<td></td>
<td>mandibularis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MASSETER GROUP</td>
<td>2.505</td>
<td>2.608</td>
<td>2.4565</td>
</tr>
<tr>
<td></td>
<td>Superficial</td>
<td>0.702</td>
<td>0.66</td>
<td>0.681</td>
</tr>
<tr>
<td></td>
<td>Temporalis</td>
<td>1.349</td>
<td>1.25</td>
<td>1.2995</td>
</tr>
<tr>
<td></td>
<td>Deep Temporalis</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zygomaticus Temporalis</td>
<td>0.767</td>
<td>0.832</td>
<td>0.7995</td>
</tr>
<tr>
<td></td>
<td>TEMORALIS GROUP</td>
<td>2.818</td>
<td>2.742</td>
<td>2.78</td>
</tr>
<tr>
<td></td>
<td>Medial Pterygoid</td>
<td>0.855</td>
<td>0.879</td>
<td>0.857</td>
</tr>
<tr>
<td></td>
<td>Lateral Pterygoid</td>
<td>0.302</td>
<td>0.385</td>
<td>0.3635</td>
</tr>
<tr>
<td></td>
<td>PTERYGID GROUP</td>
<td>1.157</td>
<td>1.264</td>
<td>1.2005</td>
</tr>
<tr>
<td></td>
<td>TOTAL</td>
<td>6.26</td>
<td>6.614</td>
<td>6.437</td>
</tr>
</tbody>
</table>
## Prototype Assembly Strategy Checklist

<table>
<thead>
<tr>
<th>CONNECTION</th>
<th>FASTENER TYPE</th>
<th>NOTES</th>
<th>PROTOTYPE EVALUATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>MUSCLES:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zygoma to LT Cranium</td>
<td>M 4</td>
<td>2 subtools, (total 4 magnets)</td>
<td>Good. Increase tolerance gap on rostral edge of rostral boss.</td>
</tr>
<tr>
<td>ST to DT to Cranium</td>
<td>M 2</td>
<td>Press fit sandwich DT b/w</td>
<td>OK. Tightening up tolerance. Several people noted appearance like piggy bank.</td>
</tr>
<tr>
<td>ZT to LT Mandible</td>
<td>M P</td>
<td>Held fixed after addition of Zygoma</td>
<td>OK. Keep as is, loosen with sanding in final.</td>
</tr>
<tr>
<td>ZM to LT Mandible</td>
<td>M P</td>
<td></td>
<td>OK. Keep as is, loosen with sanding in final.</td>
</tr>
<tr>
<td>EPEA to IPEA to ZM</td>
<td>M 2</td>
<td>Magnetic tab sandwich IPEA b/w (total 2 magnets)</td>
<td>Good. Increase depth of boss slightly, add feature to keep IPEA to ZM.</td>
</tr>
<tr>
<td>SM to LT Mandible</td>
<td>M 2</td>
<td>Approximate an over center snap type action</td>
<td>Poor. Does not stay in place try alternate connection, possibly magnetic as well.</td>
</tr>
<tr>
<td>MP's to LP's</td>
<td>M 2</td>
<td>(total 2 magnets)</td>
<td>OK. Increase depth of boss.</td>
</tr>
<tr>
<td>P/v's to LT Mandible</td>
<td>M P</td>
<td>Socket into natural shape of mandible</td>
<td>Add feature to assemble MP's to mandible.</td>
</tr>
</tbody>
</table>

| FASTENER TOTALS | 4 | 14 |

RT to LT Cranium: F
RT Mandible to RT Cranium: M 2
LT Mandible to LT Cranium: M 2
LT Mandible to RT Mandible: M 2
Zygoma to LT Cranium: M 4
ST to DT to Cranium: M 2
ZT to LT Mandible: M P
ZM to LT Mandible: M P
EPEA to IPEA to ZM: M 2
SM to LT Mandible: M 2
MP's to LP's: M 2
P/v's to LT Mandible: M P
Bibliography


Bibliography


Nicholas Reback was born in Madison, Wisconsin on April 8th, 1979. He spent his childhood 30 miles west in the picturesque rural countryside before moving to Monona, Wisconsin in 1992. He attended Monona Grove High School and graduated in 1997 with a focus on the arts and sciences.

Nicholas went on to study Industrial Design and received his Bachelors’ of Fine Arts in 2002 from the Cleveland Institute of Art in Cleveland, Ohio. After graduation a variety of cultural and work experiences ensued, including a brief stint in toy design at Hasbro in Pawtucket, Rhode Island, product design in the Louisianan Deep South, and a woodworker in Bozeman, Montana. A broken leg brought a premature end to his cultural enrichment and in the fall of 2005 he returned to his Midwestern roots.

Nicholas resumed his career in design and for the better part of the following decade he was fortunate to have the opportunity to work for Design Concepts, an award winning product development and innovation firm in his hometown. The company had a strong presence in the medical, commercial and industrial product segments. It was here that Nicholas was exposed to the disciplines of design thinking, design strategy, project management and ethnography.

Nicholas has always enjoyed learning. While at Design Concepts he continued to expand his drawing and design abilities by attending evening illustration courses at Madison Area Technical College. As his career progressed, however, a feeling of stagnation grew. This changed in October of 2012 while working on a project for David Mahvi, chief of surgery at Northwestern University Hospital in Chicago, Illinois. Nick was observing Dr. Mahvi perform a liver resection in an effort to gain a better understanding of the physical constraints inherent to working inside the abdominal cavity. The experience was nothing short of exhilarating. Sometime during the mobilization of the patients liver, the subject of Medical Illustration was mentioned. Like a bolt of lightning, Nick was struck by an epiphany. Nine months he later left his career to start his second act as a Medical Illustrator.

Nicholas entered the Department of Art as Applied to Medicine in 2015, where continued to grow his skills and immerse himself in the world medical and biological art. He is currently a candidate for a Master of Arts in 2017, and looking forward to his next adventure.